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Chapter 1. System Requirements
Phase One recommends the following minimum hardware set up:

• Pentium III minimum. Pentium 4 preferred.

• 512 MB of RAM minimum. 1GB or more preferred

• Operating system: Windows 2000/XP

• Ports: FireWire or USB depending on the camera used

Note

Multiprocessing: Capture One software supports multiprocessing. This means that when
installed on dual processor platforms image processing time is considerably reduced.
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Chapter 2. Installation
This section describes how to install the Capture One software. How to uninstall the software is also
described.

1. How to Install Capture One Software
Capture One software includes an easy-to-use installer that will install all the software you need to run
the application on your computer.

To install the software follow the procedure below:

1. Either load the Capture One CD into the CD drive, or download the application from the Phase One
Website

2. The software installer will start automatically, if it does not , or, if you downloaded the application,
double-click SetupC1.exe

3. After reading the on-screen instructions, click Next to continue the installation

4. Follow the on-screen instructions to complete the installation

Note

If you need to stop the installation, click the Cancel button

2. Standard Folders Created During Installation
The installer creates a folder on your hard disk called Capture One PRO. As well as the application, this
folder contains release notes, and, if Installed from a CD-ROM, it also contains an Extras folder.

During installation three standard folders will be created on your hard disk:

• Captures: This is the default folder where the raw capture images taken with a camera are stored.
You can create new folders to organize your raw capture files on the hard disk.

• Previews: The application automatically creates a low resolution (approximately 3-5 MB, depending
on the digital camera used) preview image to use for color and tonal adjustments. All preview files
are stored in this Previews folder. If any files are deleted from here the program will automatically
generate new previews the next time the application is started. If any previews cannot be seen, the
click the Refresh button to refresh the screen capture.

Tip

You can save a lot of disk space by periodically deleting unused items from the Previews
folder in C:\Program Files\Phase One\Capture One PRO.

• Images: By default processed images will be placed in this folder.You can easily browse through
all folders using the application's file browser function.To access the browser click on the black arrow
to the left of the capture collection tabs.

3. How to Uninstall Capture One Software
To uninstall the application, double click on the uninstall application UNWISE.EXE and follow the on
screen dialog.
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Note

The uninstall application is located inside the Capture One application's folder

4. How to Activate a License
Use of the Capture One application is controlled by a license key. Without a valid license key, which
you have activated, you will not be able to operate the application beyond its 30 day trial period. For in-
structions on how to activate your license key, see the sections, below.

4.1. How to Activate a License Automatically

If your computer is connected to the Internet and you want to activate your license automatically, follow
the procedure, below:

1. Open the application and select License activation from the Help menu.

2. The License Activation dialog box (see illustration, below) will be displayed

3. Select Online Activation

4. Enter the Product Key enclosed in the software box

5. Click the Get Registration Key button
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6. Click Activate License to complete the license activation.

Note

After clicking Activate License your software will have to be restarted for the activation
to work.

4.2. How to Activate a License Manually

If your computer is not connected to the Internet, and you want to activate your license manually, follow
the procedure, below:

1. Open the application and select License activation from the Help menu.

2. The License Activation dialog box (see illustration, below) will be displayed

3. Select Manual Activation.

4. Enter the Product Key enclosed in the software box.

5. Click the Get Registration Key button.

6. Select Manual Activation and write down the Registration key that is displayed.

7. From a computer that is connected to the Internet, go to http://www.phaseone.com/.

8. Have your Registration Key ready, click Activate Software in the menu and follow the instructions
on the site. Once the process is complete you'll have the activation key to activate your copy of
Capture One.
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Note

Make a note of your activation key. Either by writing it down, or by taking a screen
capture.

Important

Save a copy of your activation key, your product key and your log in information in a
safe place.You may need them again in the future.

9. Enter your Activation Key in the Manual Activation dialog box, then click the Activate License button
to complete the license activation.

Note

After clicking Activate license your software will have to be restarted for the activation
to work.
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Chapter 3. Getting Started
This section provides you with some basic general concepts and instructions that will help you to start
working with the application as quickly as possible. However, to get a more detailed understanding of
the application: what it is capable of and how you can use it to achieve what you want to when working
with images, you will need to refer to the other more detailed sections that this online help is comprised
of.

1. Software Basics
This section will give you a brief introduction to the application's interface and its main functional areas.
The following sections will provide a more detailed description of what these functional areas are and
how to use them.

The application's main window is made up of four functional areas. In the illustration, below, these areas
have been higlighted using colored frames. These areas are:

 Menu and toolbars

The thumbnail window. The thumbnail window displays information about your capture files and is
used to select images. When an image in the thumbnail window has been selected it becomes the ap-
plication's focus.

The preview window. The preview window displays image(s) selected from the thumbnail window.
The preview image(s) is updated in real time to show you the effect of changes that you have made to
the image.

The functional tabs. Clicking the different tabs makes then active. In this example the Focus tab is
active.
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1.1. Creating a New Session

To create a new session, follow the procedure, below:

1. Click on the Open/Create new session button  .

2. The Open/Create new Session dialog box will be displayed, see illustration, below.

3. Type the name for your new session in the Session field.

Note

You can also choose to name the session based on an existing session by selecting
one using the Existing sessions: selection box.
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4. If appropriate use the other buttons in the dialog box to choose different locations for the session
on the hard disk.

5. When you have completed entering the information for the new session, click Open.

6. A new session will now be created.

Note

When you create a capture folder in this way, it is automatically set as the current
capture folder and capture files that are captured when tethered to Capture One are
named based on the session name - in this case Beach Portrait.

1.2. Importing Images

After creating a session, the next step in a typical workflow is to add the image files to it that you want
to work with. There are two ways of doing this:

1. Connect a card reader to your computer and insert your FlashTM or MicrodriveTM card. When you
do this, a Phase One Media Reader window (see illustration, below) will automatically open.You
can choose to have your files renamed as they are imported by checking the Rename captures
check box and typing the name you want to use in the field next to it.

Note

If you choose not to rename captures, then the images will retain their names as gen-
erated by the camera that they were shot with.

2.
Click on the Browse files icon  (see illustration, below) then select the folder with the image that
needs to be viewed.

8

Getting Started



1.3. White Balancing Images

To white balance images follow the procedure, below:

1. From the capture window, select an image that contains either a gray card a neutral white or grey
area.

2. If it is not already selected, click on the White Balance tab.

3. Using the cursor, click the color picker on the gray card's neutral gray area in the image being dis-
played in the preview window.

Tip

If your image does not contain a satisfactory gray area, you should shoot the image
again and include a QP or MacBeth card in the scene.

Alternatively, use the If selected display on the white balance tab. While moving the
eye dropper around the image, the left window will indicate whether the area is suitable
for white balancing, by saying If selected (Good) or not suited, by saying If selected
(poor). The window on the right will show what the area will look like if the current pos-
ition is used for white balancing the image:
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Not Suitable for White BalancingSuitable for White Balancing

4. The selected image will now be white balanced. This white balance can be used to balance other
images and/or applied as a capture balance to new images if you are capturing tethered to the
computer.

1.4. Fine Tuning Exposure, Contrast and Saturation

Select the Exposure tab.

The Exposure tab will be displayed, see illustration, below.

Use the EC and CC sliders to adjust the image. Use the Color saturation slider to increase or decrease
the images' saturation.

If you prefer to work with levels or curves, you can alternate between the two using the Levels and Curve
tabs. The two preview windows Raw RGB and Destination display the current RGB values of the RAW
files and as they will be when output into the selected output color space, respectively.
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1.5. Focusing and Sharpening

Focusing is the process of checking focus and applying sharpening settings to an image.

To check focus and sharpness, follow the procedure below:

1. Using the cursor, select an area of the image to work with from the preview window.

2. Zoom in and out using the Zoom slider.

3. Adjust the images' sharpness using the sliders available.

Tip

The Amount is typically set around 100 for ink jet, 150 -250 for offset printing.Threshold
is used to define how many of the surrounding pixels are affected. Typically a noisy
image will have a higher threshold set, perhaps 12 -20. A clean image will need a very
low threshold of 2-4.

Keep checking the image in the focus window. For a web image, the image should look
correct on screen. For an image to be printed in a magazine or book, the preview should
ideally look slightly over-sharp on screen.

11

Getting Started



4.
When you are satisfied with the adjustments made, click the  button to apply them to the selected
images.

Note

The area shown in the focus window can be moved either by moving the focus in the preview
window, or by panning in the focus window.

1.6. Image Processing

To process images, follow the procedure below:

1. Using the mouse, select the image you wish to work with and then select the Process tab.

2. Configure all of the appropriate settings. For detailed information on the options available and how
to use them, see Section 1.3, “Process Tool Fields”.

3.
Click the Process Batch icon  at the bottom of the Process tab.

4. Processing of your images will start. All selected captures will be processed according to the settings
in the process panel and in the processing preferences. Images are being stored in your selected
Processed folder with the individual file names.

While images are being processed a progress bar will be displayed at the bottom of the Process tabs.

Note

For information on how to cancel processing of an image or stop processing a series of
images, see Section 1.3, “Process Tool Fields”.

1.7. Batch Processing

Batch processing is used for processing more than one image at a time - it comes in handy when you
want to process several images in a similar manner.

Select the Process tab. Using the Batch Editor (see illustration, below) you can manage the creation
and processing of batches of images. The processing will start as soon as you add an image to the
batch but can be stopped and re-run at any time.

Use the add button to add images (selected in the
capture view) to the batch. The Batch processing
starts automatically when an image is added.

Use the process batch button if you want to start
the process manually.
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Use the remove button to remove an image from
the batch after selecting it from the batch list.

Use the stop process button to bring the processing
of images to a halt.You can always start the pro-
cessing again with the process batch button as ex-
plained above.

2. How to Set Up the Hardware
This section describes what has to be done to set up the hardware if you are going to be shooting
tethered .

Note

This section only applies to photographers shooting tethered with a Phase One camera
back.

Note

Your computer must have a minimum of 1GB RAM.

2.1. Installing the PCI IEEE-1394 Card

The Phase One camera back is connected to the computer via an IEEE 1394 connection.This extremely
fast connection does not have many of the limitations of the SCSI technology previously used in older
digital cameras. If necessary, the cable length can be extended using Phase One Power Conditioners
to move the camera further from the computer.

To install a PCI IEEE-1394, follow the procedure, below:

Note

Whilst this procedure will work in most cases, it is important that you have read and under-
stood the user information (manual, online help, etc.) for your own computer, before carrying
out this installation.

1. Shut down and un-plug the computer.

2. Remove the computer's cover to get access to its motherboard.

3. Choose an empty PCI slot and remove the screw and cover.

4. Gently place the card into the slot with the 1394 connectors facing through the opening.

5. Exert a firm downward pressure straight down on the card whilst rocking it slightly until it is firmly
seated in the slot.

6. Replace the screw to hold the card in place.

7. Replace the computer's cover, then restart it.

2.2. Setting Up the Phase One Equipment

In addition to setting up the computer, the camera also has to be set up for working with the Phase One
camera back.

To set up the Phase One Equipment, follow the procedure, below:
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1. A Ground Glass Mask is included.This must be installed in the viewfinder to ensure correct framing.
Remove the camera viewfinder and focusing screen (refer to the camera user's manual for detailed
instructions). Insert the Ground Glass Mask and replace the viewing screen and the viewfinder.

2. Connect the Phase One camera back to the camera or mounting plate.

Important

Ensure that the back is firmly connected to the camera before releasing it.

The small screw on the top of the Phase One camera back H series can be tightened with the
screwdriver supplied to prevent it from being accidentally removed. Phase One's P series camera
backs are equipped with a locking mechanism.

3. Connect the supplied Sync Cable from the lens' flash sync to either the connector on the Phase
One camera back marked "C" or the Mamiya Mounting plate. This is the same for Phase One's H
and P series camera backs.

4. If a motorized camera is used, connect the included Motor Cable to the connector on the right hand
side of the back, marked "M". This is the same for Phase One's H and P series camera backs.

5. If a Mamiya RZ67 Pro II is used, connect the mounting plate to the camera and then connect the
cable from the mounting plate to the connector on the front of the Mamiya. Ensure that the cable
is connected and locked properly; the latching mechanism will be on the bottom.

6. If flash is used, connect the Flash Sync Cable (not included) from the strobes to the connector on
the right side of the camera back, marked "F". This is the same for Phase One's H and P series
camera backs.

7. Connect one end of the IEEE 1394 cables (included) to any one of the empty ports on the newly
installed card, or the built-in port. Connect the other end to the back of the Phase One camera back.
These cables can only be inserted one way and may require a little pressure to insert.

Note

For the Mamiya RZ the camera must be set to take multiple exposures in order to use the
Phase One camera back.The multiple exposure selector (M) is combined with the film back
revolve switch (R).

2.3. Understanding the LED Indicator Lights

LED Indicators lights: On the back of the Phase One camera back are two sets of LED indicator lights.
A red and green light on the left and a red and green light on the right. The left and right pairs are
identical and should always display the same thing. These lights indicate the camera back status. The
list below describes what the status lights indicate:

• Green Lights Steadily On: this means that the Phase One camera back is receiving power and is
ready to capture images.

• Green Lights Flickering: after capturing an image the green lights will flicker on and off while
transferring the image to the computer.

• Both Red and Green Lights Steadily On: if the camera is not shut down properly, or an error occurs
both sets of lights may stay lit. If this happens, shut down the Capture One software, unplug the
camera back, wait ten seconds, then reconnect the camera.

• No Lights On: if the camera is properly plugged in and receiving power and there are no lights on,
the camera back has shut down or may be damaged. Unplug all connectors, inspect all cables for
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damage, examine the IEEE 1394 card (if in use) for proper installation and reconnect everything. If
the problem persists, contact your Phase One dealer for assistance.

2.4. Working With Other Photographic Equipment

While the Phase One camera back has been made as compatible as possible with photographic
equipment, there are a few issues to be aware of:

• When using the Phase One P20/P25 camera back with a Hasselblad 555ELD, the release button
on the front of the Hasselblad needs to be in the "DIGI" position. If the camera back is turned around
to support landscape or portrait mode (depending on the CCD placement in the back) the release
button needs to be in "FILM" position.

• When using the Phase One camera back on a view camera, use "Two Shot Mode". This means that
the shutter release is activated twice. To shoot an image, release the shutter, reset it, and shoot
another frame. The first shot 'wakes' the camera up, and the second is the actual exposure. Altern-
atively pressing the Capture button in the preview window will wake the camera up and then the
shutter can be fired once to take a photo. The camera will remain 'awake' for 5 seconds or until the
next capture.

• When used on a Mamiya RZ67 Pro II the selector on the right side of the camera body must be in
the "M" position.

• The Phase One camera back fully conforms to ISO 10330 Standard for Photographic Strobe Systems;
unfortunately, not all strobe manufacturers comply with this standard. Check with the manufacturer
of your strobe system to prevent damage to the Phase One camera back.
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Chapter 4. Main Window Overview
1. Main Window
The application's main window is comprised of four functionally separate areas, which support the
workflow used when capturing, adjusting and processing images.

1.1. Folder Browser Window

The folder browser window (see illustration, below) is used to locate and organize the images that you
want to work on. It has four buttons, which have the following functions.

Refreshes the browser view. Use this if you've just
created a new folder and it doesn't show up in the
folder browser.

Adds a folder as a permanent capture collection.
This means that even after closing and reopening
Capture One, the folder will be available as separate
tab.

Creates a new folder in the folder browser - that is,
on your actual file system.

Reorganizes the windows and put the folder
browser underneath the capture collection - you
can toggle this back by clicking the button again
after the windows have shifted place.

16



1.2. Capture Collection Window

The capture collection window (see image, below) is actually a list of capture folders. Each tab is a
capture folder, capture folders can be added or removed from the view. All captures in a folder are dis-
played as thumbnail views. In addition to the view of the image itself, the capture name, capture id, and
date (when available) will also be displayed next to each image.

Just above the capture collection window is a capture naming field. The name in this field is used as
default name for the next capture. If it is blank the name will default to the camera back's serial number
when shooting tethered with a Phase One camera back.

1.3. Preview Window

The preview window (see illustration, below) displays the currently selected capture file. The window
automatically expands to display the largest possible preview. If you collapse the Capture Collection
window and/or the Folder Explorer window, the preview automatically enlarges to fill the screen.
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1.4. Function Tabs

The function tabs (see illustration, below) represent the main stages and operations of the workflow.
There are five tool tabs:

• Capture

• White Balance

• Exposure

• Focus

• Process
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1.5. Menus and Toolbar Reference

The application's menu and toolbar allow you to select tools and carry out operations when working with
your images.

2.Tools Reference
This section contains a detailed description of the application's tools. All tool buttons are equipped with
"Tool Tips" - when you place the mouse over a button, a note will pop up that briefly describes what the
button does, and, if applicable, show you the keyboard shortcut:

The Eyedropper tool is used to read the RGB or
CMYK values of a particular area of an image. The
area measured by the tool is 3x3 pixels.

The Zoom tool is used to zoom in (magnify) an im-
age. Click on the preview image to zoom in. Hold
down the Alt key at the same time as using the
zoom tool to zoom out again Remember, the pre-
view image is only a low resolution image and will
quickly pixelate when enlarged. Click the arrow to
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the right to access a zoom slider appears (see illus-
tration, below), which also allows you to zoom in
and out.

Using the Rotation tool you can rotate images by a
fixed 90º left or right.

To rotate images by an arbitrary rotation use the
rotation cursor tool, see illustration below. Using
the rotation cursor tool you can adjust the image's
rotation by aligning a horizontal or vertical line
(which you draw) with a line in the image. The rota-
tion of the image will be adjusted to be parallel to
the line you drew.

Using the Cropping tool you can crop an image so
that any unwanted parts of the image will be re-
moved. Click and drag the mouse so that a box is
drawn surrounding the area of the image to be se-
lected.Then release the mouse button.The rectan-
gular box, which now surrounds part of the image,
can be adjusted in size and position. There are
points at the corners of this box, that can be clicked
and dragged, to change size and position. When
turned on, the Crop Mask Tool will mask the area
of the preview image that is outside the selected
crop area. Right-clicking the crop tool opens a new
Tool settings menu (see illustration, below), which
you can use to select the color and opacity of the
crop mask to be set. This tool is a useful feature
when showing images on-screen, as the cropped
area is clearly shown.

The Exposure Warning tool quickly shows which
areas of the image are either overexposed or under-

20

Main Window Overview



exposed. The exposure tool is analogous to Pho-
toshop's Gamut Warning tool. When the exposure
warning tool is activated a colored mask will be
applied to the image showing which areas of the
image are above or below a set exposure value.
Right-clicking on the tool icon gives access to the
Tool Settings box in which tool parameters can be
adjusted.

In general, if the exposure warning is shown over
a large area of the selected image, it indicates that
the exposure level may need to be adjusted. High-
light areas are more critical than shadows. Preserve
highlight detail by not allowing values greater than
240.

Selecting the Gray Scale button selects that the
preview is shown in gray scale.This does not affect
the processed file.

Selecting the Simulate Sharpening settings button
displays the preview of the image using the spe-
cified Unsharp Mask (USM) settings. To alter the
USM settings open the Preferences/Miscellaneous
Settings dialog box. The name Unsharp Mask
(USM) can be misleading. Using this tool actually
gives an apparent increase in image sharpness by
enhancing the edge differences between pixels of
different colors. When applied, the software evalu-
ates the contrast differences between pixels and
either enhances the difference or not, based on
setting made in the preferences. USM has two set-
tings:

• Amount: the amount of change is entered here
as a percentage. The higher the setting, the
higher the degree of sharpening that will be ap-
plied.

• Threshold: the threshold level controls at what
level the sharpening will begin. At the default 0
setting, the sharpening amount is applied to
every pixel. As you adjust the setting upwards,
you change the level at which the sharpening
will begin.

Use the Zoom-to-fit button to set the preview win-
dow so that the image will always zoom by the ap-
propriate amount to fit the preview window.

Use the Hide/Show Function Tabs button to maxim-
ize your view of the image in the preview window.
Clicking the button once minimizes the function tabs
and maximizes the preview window. Clicking it again
works the other way around: it expands the function
tabs and reduces the size of the preview window.
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3. Cropping and Rotation
Using the application's cropping and rotation functions allows you to crop your images to the appropriate
size and rotate them to apply the orientation that you want in your final picture. Images can be cropped
at any stage in the workflow.

3.1. How to Crop Images

To crop images follow the procedure below:

1. Select the cropping tool by clicking the cropping button  on the toolbar.

Note

To select a preset aspect ratio, click the selection arrow  next to the cropping button.

2. The aspect ratio dialog box (see illustration, below) will be displayed.

3. Choose the aspect ratio that you want to work with.

4. Click and drag to dimension the crop box on the image that you want to crop in the preview pane.

Note

A crop from one image can be applied to all selected images. After marking up the crop, go

to the Process tab and click the Apply to current selection of captures button . This will
bring up the Apply Settings dialog box:
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Tick the Only settings from current tab to limit the settings that are applied to just the crop
and not any other changes you have made to the captured image.

3.2. How to Rotate Images by Preset Amounts

To rotate images by preset amounts follow the procedure, below:

1. Select the image which you want to rotate by clicking on its thumbnail image.

2.
To rotate the image left or right by 90 degrees by clicking  or  respectively.

Note

Images can also be rotated directly from the capture collection window by selecting an
image, right clicking on it and then choosing Rotate from the displayed menu.

3.3. How to Rotate Images Arbitrarily

To rotate images based on an arbitrary line follow the procedure, below:

1. Select the image which you want to rotate by clicking on its thumbnail image.

2.

Click on the Arbitrary Rotation tool .

The preview will expand to a maximized view of the image.

3. Click and drag on the image to draw a line (as shown in illustration, below).

4. The image will rotate to be parallel with the drawn line.
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5. Clicking the rotation cursor tool again will apply the rotation to the image and return you to the ap-
plication view, as it was before using the rotation tool.

3.4. How to Rotate Images by Fixed Amounts

To rotate images based by fixed amounts follow the procedure, below:

1. Select the image which you want to rotate by clicking on its thumbnail image.

2.

Click on the Arbitrary Rotation tool .
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The preview will expand to a maximized view of the image.

3. Rotate the image by entering the degrees of rotation that you want to apply in the cursor tool's Image

Rotation  field.

Tip

If you are unhappy with the rotations you have performed on an image, Inserting a
value of 0 in the Rotation Tool's free text area returns the image to its original rotation.

4. Clicking the rotation cursor tool again will apply the rotation to the image and return you to the ap-
plication view as it was before using the rotation tool.
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Chapter 5. Organizing Images
1. Sessions: Organizing Files
Sessions are used to organize your image files. Different sessions can be created and configured differ-
ently to closely match the specific requirements of the task that you are working on. Organizing your
image files in a logical way at the capture stage is likely to save you time during the processing of these
images. For example, if you go to the beach to photograph for a catalogue you can create one capture
collection folder called Beach Portraits in advance.

Note

Image names can be altered at all times by clicking on the capture name fields at the bottom
of each thumbnail.

1.1. How to Create a New Session

To create a new session, follow the procedure, below:

1. Click on the Open/Create new session button  .

2. The Open/Create new Session dialog box will be displayed, see illustration, below.

3. Type the name for your new session in the Session: field.

Note

You can also choose to name the session based on an existing session by selecting
one from the Existing sessions selection box.

4. If appropriate use the other buttons in the dialog box to choose different locations for the session
on the hard disk.

5. When you have completed entering the information for the new session, click Open.

6. A new session will now be created.
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Note

When you create a capture folder in this way, it is automatically set as the current
capture folder and files captured tethered to the computer are named based on the
session name - in this case Beach Portrait.

All processed capture files are stored in a sub folder called Develops in your installation folder, for example
C:\Program Files\Capture One\Captures\Beach Portrait\Develops, which is automatically created when
you check the box Process capture inside folder "Develops" in the Open/Create new Session dialog
box, see illustration, above.

The name can be altered at any time during shooting, or more folders can be added.

You can enter a name in the Session field of the capture collection window. All subsequent images
captured tethered will now be named based on what you entered.

1.2. How to Automatically Name and Number Capture Files

To automatically name and number files as you capture them, follow the procedure, below:

1. Open the preferences window by clicking File>Preferences, or pressing ALT-P together.

2. The Preferences window will be displayed.

3. Click the Capture output tab, the tab's contents will be displayed, see illustration, below:
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4. Enter a number in the Delimiter field (up to a maximum of 6 digits).

5. Check the Always include number check box and a sample of the naming and numbering will appear.

6. Click OK.

7. All your new captures will now be named based on the values that you have entered.

2. Selecting and Editing Images
For ease of use the Capture One application's main window is split into three functionally different areas.
These are:

• Capture Collection, which displays thumbnail images of the capture files.

• Preview window, which displays a preview of the selected capture file.

• Function tabs with tools for capturing, validation and image adjustments.

The following sections explain how, working in these areas and using the functionality that they provide,
you will be able to select and edit your images to achieve the results you want.
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2.1. Exploring Folders

In the capture collection panel you can view and work with your capture files. To open a file browser

window, click the arrow button  to the left of the capture folder. A file browser window (see illustration,
below) will be displayed. To close the file browser, click the arrow button again.

2.2. Working with Thumbnails

The thumbnail area (see illustration, below) displays thumbnail views of the images in the current capture

folder. Thumbnail sizes can be changed by using the  button at the top of the window. Thumbnails

can be sorted by capture name or date. Clicking  in the thumbnail window toggles between the two
sorting options.

File Tagging: tagged thumbnails in the capture collection have a check mark in their upper left hand
corner. Images are tagged by first selecting them from the capture collection and then clicking the tag

 button.

Deleting Images: images can be deleted by selecting them and pressing the Delete key on the keyboard.
Alternatively, drag and drop the selected thumbnails into the Trash folder.You can also select multiple
captures using Ctrl + click and then deleting the group of images as described above. Trashed images
will be stored in the trash can until they are permanently deleted from there by selecting the trash can

and then clicking the  button. If you need to recover images that have been trashed by mistake, drag
the capture out of the trash and back into a capture collection folder.

Note

Once the trash has been emptied the captures will be permanently deleted.

Capture Information: the additional text information to the right of the thumbnails can be toggled on and

off by using the thumbnail information  button. This will display extra information about the capture
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image, some of which is meta data. For example, the Capture ID, Capture time, and EXIF information:
ISO, Exposure time, Aperture etc. For a complete display of all available meta data, right click on the
image and select Show Information from the menu that is displayed.

Add Annotations: you can enter some additional information about the capture images by right clicking
an image in the capture collection. This opens the Capture Annotations dialog box into which you can
add the notes that you want to have associated with the file.

2.3. Working with Previews

The preview window provides you with a detailed and scalable preview of either a single selected image
or two images, which can be displayed next to each other to allow comparisons to be made between
them.

To select an image to be previewed, click on its thumbnail in the Capture Collection window.

You can change the zoom applied to the preview image to make a more detailed examination of it
easier. See Section 2, “Tools Reference” for information on how to use the zoom tool.

You can expand the preview area by minimizing the function tabs display. See Section 2, “Tools Refer-
ence” for information on how to do this.

2.4. Comparing Multiple Images

In the preview window, two captures can be compared side by side (see illustration, below).This is done

by clicking the side by side icon  on the toolbar. The main purpose of side by side evaluation is to
make it easy to select the best capture from a range of almost identical capture files.

To switch the position of the images that you are comparing, click the switch position  button.
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Chapter 6. Capture
1. Capturing Tethered
When you are capturing images while tethered to a computer and with the capture selected, the Capture
One PRO application will display:

• Information about the images being captured.

• Current settings.

• Status of the system.

When capturing tethered, exposure can be evaluated in the Exposure evaluation histogram at the top
of the panel.

Note

Remember to include a grey card in one of the captures for white balance calibration.

1.1. How to Capture Images

When you have finished setting up the capture settings you are ready to start capturing images.To begin
capturing images, follow the procedure below:

1. Turn on the camera and set it up for RAW capture (Quality must be set to RAW).

Note

The camera's white point is overruled by the White Balance set in the Capture One
software (certain DSLR and P series Phase One cameras only).

2. Connect the camera to the computer through an IEEE 1394 (FireWire) or USB cable.

3. If you are shooting tethered (with one of the cameras supported by the application) make sure that
the DSLR software drivers that come with the camera are installed on the computer.

4. Open the File menu, and select Reconnect Camera to detect the camera.

Note

Phase One digital backs connect automatically. If another camera model is connected
and the software recognizes it the camera status will state that the camera is connected.

5. You are ready to shoot directly into the Capture One application.

6. To capture images when shooting tethered with Phase One camera backs, either click the Capture
button, or push the capture button on the camera that you have connected to the application.

32



Chapter 7. White Balancing Images
The White Balance tool is used to make white balance adjustments to your captured images. Working
with Capture One this is a simple and easy process using a gray card or selecting a neutral gray area
to adjust the balance of your images. In addition, you can make manual adjustments to images if needed.

1. How to White Balance Images
To white balance images follow the procedure below:

1. From the capture window, select an image that contains a gray card or a neutral gray area.

2. If it is not already selected, click on the White Balance tab.

3. Using the cursor, click the color picker on the neutral gray area in the image being displayed in the
preview window.

Tip

If your image does not contain a satisfactory gray area, you should shoot the image
again and include a QP or MacBeth card in the scene.

Alternatively, use the If selected display on the white balance tab. While moving the
eye dropper around the image, the left window will indicate whether the area is suitable
for white balancing, by saying If selected (Good) or not suited, by saying If selected
(poor). The window on the right will show what the area will look like if the current pos-
ition is used for white balancing the image:

Not Suitable for White BalancingSuitable for White Balancing

4. The selected image will now be white balanced. This white balance can be used to balance other
images and/or applied as a capture balance to new images if you are capturing tethered to a com-
puter.

Tip

To avoid re-doing the same white balance settings for every new image, Capture One allows
you to store your own white balance settings and reuse them on other images. Here's how
you do it:

1. Adjust the white balance settings to your liking.

2.
Click the Save White Balance button . This will bring up the Save As dialog:
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3. Enter the name for your settings and click the Add button.

4. Now you can reuse your white balance settings by selecting them from the drop down
menu in the white balance tool:

2. White Balance Tool Fields
The White Balance Tool contains the following fields:

Use this button to apply the selected white balance setting to
all future captures.

Use the button to reset the color balance to the last saved value.
Any color balance adjustments that you have made to the image
will be lost.

Use the button to reset the color balance to that of the original
shot.

Use this button to have the application calculate and apply a
suitable white balance.

Use this button to apply the selected white balance, ICC Profiles
or Lens Cast calibrations to the current selection of captures.
When this button is clicked a dialog box (see illustration, below)
will be displayed.
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The left window will show you where the eye dropper tool is
situated in the image, and the right hand window shows how
the image will look if you use this spot to adjust the white bal-
ance. Check out the tip in Section 1, “How to White Balance
Images” for details.

Use this slider to change your image to be "cooler" or "warmer".

Use this slider to change the tint toward green or magenta

Use this wheel to change the color of your image by dragging
the center "x" in the direction of the color you would like to add.

The hue and saturation bars next to the wheel allows you to fine
tune the color once you have placed the "x" where you want it.

Use this selector to browse for a Lens Cast Calibration file to
apply to the selected capture. Check out Section 1.5, “Calibrating
fixed lenses” for an explanation of how to create and load calib-
ration files.
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Chapter 8. Exposure Evaluation
The exposure tool is used to evaluate and, if necessary adjust an image based on its exposure. It
provides a visual, histogram based, illustration of the exposure of a selected image. Based on this, or
working to predetermined settings, the exposure characteristics of an image can be adjusted.

The exposure tool uses an RGB color readout in both the Raw files (the raw images) and in the Destin-
ation (which reflects how it will be in the processed image).

You can obtain precise values for any point on the image by resting the cursor on it - mouse around and
you'll see the RGB value changing in the upper right hand corner of the window:

Knowing the precise values of any part of the image gives you full control over the printing process.
Printers and printing processes all have individual characteristics. Adjusting exposure levels helps to
ensure a predictable, high quality result matching your specific output needs.

1. Exposure Tool Fields
The Exposure tab (see illustration, below) contains the following fields:

Film standard selection box: use this selection box to choose which film curve is applied

• Film Standard: this is the default film curve

• Film extra shadow: this curve applies slightly more detail to the shadow areas of an image

• Film outdoor: this curve is especially suitable for use in outdoor daylight. The curve is designed to
gain data in the high light areas whilst still maintaining contrast.

• Linear response: exact linear response will transfer the Image as it was taken with the camera,
without the application applying any filtering or adjustments. This is especially useful for scientific
photography and very high contrast scenery.

EC: Exposure compensation. Allows you to correct the images' exposure if you have taken an image
that is to dark or to light (under or over exposed respectively).

CC: Contrast compensation. Allows you to increase or decrease the contrast of a image.

Use this button to autocorrect the exposure in your
image. Capture One will use proprietary algorithms
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to try to estimate the best exposure correction for
you.

Use this button to reset highlight and shadow levels.

Use this button to reset all curves and levels.

Use this button to load exposure settings.

Use this button to save exposure settings.

Use this button to apply any adjustments made to
all the images selected in the capture collection.

Levels: displays a histogram of the image's levels. Points in the histogram are plotted on a scale from
0 to 255. A completely black pixel has a value of 0 whilst at the opposite end of the scale a completely
white pixel has a value of 255. It is important not to overexpose an image (clipping); if you see any of
the Red, Green or Blue (RGB) values approaching overexposure (a value of 255) you need to adjust
the exposure level. Keep image highlights (areas that should record as white with detail, and not as a
specular reflection) between 225 and 255.

Curve: use this display to adjust the image's exposure levels. An image curve is a graph that reflects
the original image data (X-axis) and the output or developed data (Y-axis). Dark tones are placed to the
left, while the light colors are placed on the right. The default curve is a straight line. By clicking on the
displayed curve, you can add an adjustment handle (displayed as a circle). Click and drag these to adjust
the curve. In this way you can adjust and control every tone in the image.

Note

The Curve control may have a huge impact on the result and it should be used with caution.

Note

Click on the Apply to Selection  button to apply any adjustments made to all the images
selected in the capture collection.

Preserve Balance: when selected ensures that all three color channels are adjusted simultaneously. If
this box is not checked, you can control each color channel separately using the Red, Green and Blue
channels.

Raw RGB: displays a preview of the image, before any adjustments have been applied to it.The preview
is based on a selection of the preview images made using the cursor picker.

Destination: displays a preview of the image, after any adjustments have been applied to it.The preview
is based on a selection of the preview images made using the cursor picker.

Color Saturation: used to set the saturation level of the image, which shows how much color is applied.
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Chapter 9. Focus and Sharpness
The Focus Tool is used to assess and make adjustments to an image based on its focus and USM
(unsharp mask) sharpness settings. The tool's focus window displays a fully processed version of the
image, which you can then use to assess any adjustments that you have made to the image.

Using the sharpening will actually increase sharpness by enhancing the edge differences between pixels
of different colors. When applied, the software evaluates the contrast differences between pixels and
these are either enhanced or omitted based on the settings applied.

1. How to Focus and Sharpen Images
To check focus and adjust sharpness, follow the procedure below:

1. Using cursor, select an area of the image to work with from the preview window.

2. Zoom in and out using the Zoom slider.

3. Adjust the image's sharpness using the settings and sliders available.

4.
When you are satisfied with the adjustments made, click the  button to apply them.

Note

The area shown in the focus window can be moved either by moving the focus in the preview
window, or by dragging in the focus window.

2. Focus Tool Fields
The Focus tab (see illustration, below) contains the following fields:

Use this button to automatically update focus win-
dow .

Use this button to show the focus in gray scale.This
does not affect the developed file, it just makes it
easier to see the focus preview.

Use this to change the size of the focus view
between small, medium and large.

Use this button to apply the adjustments made to
selected images.

Focus Window: (the representation of the image between the buttons and the Zoom slider).

Zoom: use this slider to zoom into or out from the selected image.

Method: use this selection box to choose from the preset methods.

Amount: use this slider to adjust the amount of sharpening applied to the image. The default value is
35.

Threshold: use this slider to adjust the threshold value above which adjustments will be made.The default
value is 3.
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Note

If you would like to see your sharpening settings on the preview image you can enable or

disable it by clicking the Simulate sharpening settings button  on the toolbar.
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Chapter 10. Processing Images
1. Processing Images
Having completed your adjustments and generated images within the application that you are satisfied
with, the final stage of the workflow is to process the images.

The process panel is used to organize the output at the end of your workflow. Using the process tool,
you can choose a destination folder and select multiple variations of selected images. For example, you
may need a large image and a web image version of each image. Using the process tool, these can be
generated simultaneously.

Images captured by a Phase One camera back are stored as Phase One Raw capture files. Images
from supported DSLR cameras also have to be in their native raw format. Only raw files can be pro-
cessed by the Phase One Capture One application. To process the images, click the Process Batch

icon  at the bottom of the panel. All settings in the process panel are stored as default settings and
can be reused or changed at any time.

1.1. How to Process Images

When you have made the adjustments you wish to apply to your images (see Section 1.3, “Process Tool
Fields” for details), it's time to start processing them into the output formats. To process one or more
images, follow this procedure:

1. Select the image(s) you wish to process from the thumbnail window.

2. Select the Process tab.

3. Click the Add button  to add the selected image(s) to the batch processing queue.

The processing starts automatically when images are added, but if you have halted the process,

you can run the processing again by clicking the Process Batch button  again.

While images are being processed a progress bar will be displayed at the bottom of the Process tabs.

Note

For information on how to cancel processing of an image or stop processing a series of
images, see Section 1.3, “Process Tool Fields”.

1.2. Working with Multiple Outputs

Using the application's multiple outputs feature allows you to output the same images to multiple destin-
ation files simultaneously.

To produce multiple outputs from the same image you have to enter the output parameters on the image
tabs: Image 1, Image 2 and Image 3. After clicking the tab (it has to be enabled by checking Enable
output) you will be able to access and fill out the output parameter fields on each tab. The same image
can now be set up to be processed with different sizes, resolutions, file formats and compressions:
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After setting up the output parameter, the images are added to the processing batch. Images can be
named in the Image title field. Naming images at this stage will make it easier to find and identify the
photos later. If no name is assigned, the application names images automatically, based on selected
preferences.

1.3. Process Tool Fields

The Process tab (see illustration, below) contain the following fields:

Enable output: use this check box to enable the Image tabs used to process multiple outputs simultan-
eously.

Scaling%: using Scaling% you can set the desired output size and resolution for the image or crop .

Width and Height : these are the actual measurements of the processed file(s), taking into account the
scaling made with the Scaling% controls. The size can be measured in either pixels (px), inches, centi-
meters or millimeters. Which units are used are selected using the selection box. Typing in the size
fields will adjust the crop to the new size and therefore change the actual file crop. If you want to scale
the size to a specific size use the Scaling% control.

Resolution: using the Resolution field you can set the final image resolution. Resolution can be set in
pixels per inch, pixels per millimeter or pixels per centimeter.

File format: use this field to choose the output format that you want. The formats available are:

• TIFF

• JPEG-High

• JPEG-Medium

• JPEG-Low

Bit Depth: use this field to select the bit depth that you want the processed image(s) to have.

Note

This field is only available when the TIFF file format has been selected.

File size: these two fields indicate the size of the processed image and the amount of free disk space
remaining on the destination media.

Color Management workflow: use this field to select the color management profile that you want to apply
to the images as they are processed. The following options are available:

• Embed Camera Profile: use this profile to have the application automatically embed the selected
ICC camera profile in the processed TIFF file. The embedded profile then serves as a conversion
table that can be used by other applications, for example, Adobe Photoshop.

• Convert to Generic Grayscale: embeds a generic gray scale profile in the processed TIFF or JPEG
file.

• Convert to Destination automatically embeds the selected ICC destination profile in the processed
TIFF file. The application will convert the image on-the-fly to the default workspace or to CMYK.

To use color management effectively, the profiles of the camera, monitor and destination must be defined.
If all three devices are not correctly specified there is a risk that the final image will not correspond to
the captured image.The Capture One software installs basic profiles for a number of supported Camera
backs as well as generic monitor profiles and a wide selection of destination profiles for print, web or
proofing purposes.
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Batch Editor: use this field for managing the batch processing of images.

Tip

By ticking the Automatically open processed images checkbox, the image(s) will be opened
in the application you have associated with the file type you are producing, once the pro-
cessing is done:

Most likely the associated application is Adobe Photoshop.

Warning

Do not enable this feature if you're processing a large amount of images, as
your computer might freeze up.

2. Batch Processing
Using the Batch Editor field and icons on the Process tab (see illustration, below) you can manage the
creation and processing of batches of images. A number of images can be added to the batch and then,
when all of the images that need to be developed have been added to the list, the batch can be processed.

 use the develop button to process an individual image and to automatically process images selected
in the thumbnail view

 use the add button to add images (selected in the capture view) to the batch without processing
them.
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 use the remove button to remove selected images from the batch.

 use the process batch button to start the processing of the image batch that you have created.

 use the stop processing batch button to cancel the processing of images in a batch.

 use the view processed image button to access and view a list of the most recently processed images.

 use the set image folder button to cancel select where the application should store the developed
images.

 use the browse current folder button to browse the folder that is currently set as the image folder
where processed images from the batch will be stored.
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Chapter 11. Color Management
The Capture One application is designed to work as part of an ICC color management workflow. The
camera, monitor and printer are specified in the Capture One application, and the processed image will
be customized for that specific input and output configuration. This section describes how to use the
application's color management functions to achieve the results that you want.

1. Working with Color Management
Capture One uses color management with ICC profiles to ensure correct colors all the way from image
capture to final image. This means that when working on a properly setup system the image you see
on the monitor will look exactly like the final image. An ICC profile is a description of how a device sees,
displays and prints colors.

When working with ICC color management in Capture One an ICC profile for the camera and the mon-
itor has to be specified. Optional ICC profiles for other outputs (destinations) can be specified at any
time.

By default, Capture One installs ICC profiles for all the supported cameras as well as a wide selection
of destination profiles for printing, web publishing, and proofing purposes.

1.1. A Guide to Color Management Settings

The Color Management Settings dialog box (see illustration, below) allows you to manage your color

management settings. To access this dialog box, right click the color management button  on the
toolbar.

Camera Product: Select your camera to define which input profile should be your default for that camera.

Camera Profile: The Flash Camera profile is selected by default. Select the appropriate profile from:
Flash, Tungsten, Outdoor, Daylight or Portrait.
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Note

Only Capture One PRO provides CMYK output - one of the many advantages of Capture
One PRO over Capture One LE and Capture One SE.

Output destination (Working Space): Select the profile for your screen output.

Web Destination: Embeds the selected web destination profile in the processed TIFF or JPEG file. The
application converts the image to the default workspace or to CMYK on-the-fly.

Proof Destination: Embeds the selected proof destination profile in the processed TIFF or JPEG file.
The application converts the image to the default workspace or to CMYK on-the-fly.

Monitor Profile: A default monitor profile can be selected. To enable the monitor profile selection check
the Unlock Monitor profile selection menu box.

1.2. Selecting the Color Management workflow

When setting up ICC profiles select from the Process tab/Color Management workflow (see illustration,
below) you have the following options:

Convert to Destination: Automatically embeds the selected ICC destination profile in the processed TIFF
file. The application will convert the image on-the-fly to the default workspace or to CMYK.

Embed Camera Profile: When selected the image is not converted by any ICC profiles. Instead the
camera profile is embedded into the final image. Even when only embedding the camera profile an ap-
plication like Photoshop will still be able to show and handle the image with the correct colors. The be-
nefit of using Embed Camera Profile is that the original image date is untouched and the number of
color conversions that the image needs to undergo can be minimized.

Convert to Generic Grayscale: embeds a generic gray scale profile in the processed TIFF or JPEG file.

Convert to Web Destination: Embeds the selected web destination profile in the processed TIFF or JPEG
file. The application converts the image to the default workspace or to CMYK on-the-fly.

Convert to Proof Destination: Embeds the selected proof destination profile in the processed TIFF or
JPEG file. The application converts the image to the default workspace or to CMYK on-the-fly.

Note

To use Color Management effectively, the profiles of the camera, monitor and destination
must be defined. If all three devices are not correctly specified there is a risk that the final
image will not correspond to the captured image. All of these must also be properly calibrated.

The Capture One application installs basic profiles for Phase One Camera Backs as well as generic
monitor profiles and a wide selection of destination profiles for print, web or proofing purposes.
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1.3. Using Other ICC Profiles

It is possible to create your own ICC profile and import it into the Capture One application.

For Windows 2000, place the desired profile in the Color folder under C:\WinNT\System32\SpoolDrivers.
For Windows XP it must be placed under C:\WINDOWS\System32\Spool\Drivers.

Restart the application and the new profile will appear in the Preferences pop-up menu. Using third-party
software, customized printer or monitor profiles can be made and installed. This gives greater color
management control of the workflow environment. The smoothness slider makes color adjustments
smoother. By enhancing the smoothness a red color correction will slightly affect neighboring colors like
magenta and yellow as well.

2.The Color Editor
The Color Editor is accessed from the Workflow menu. The purpose of the tool is to provide you with
the option of adjusting predefined camera profiles to fit individual color requirements. The Color Editor
works with Phase One's predefined camera profiles.To start the Color Editor, select the image you want
to adjust the profile on and select Color Editor from the Workflow menu (see illustration, below).

Selecting The Master Profile: open the Color Editor tool from the Workflow menu, and select the profile
you wish the adjust from the Master profile selection field.

Making Color Adjustments: all adjustments are made to a copy of the original profile. The Capture One
software automatically copies the master profile to avoid unintended overwriting of an original profile.
Use Save As to store the adjusted profile under a new name once all corrections have been carried out.
All new profiles are added to, and can be selected from the camera profile drop-down box in the Color
Management dialogue box.

New profiles are added to, and can be selected from the ICC Profile field in the Capture Panel, or in the
Color Management preferences.
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2.1. Local Color Adjustment

Using the color wheel in the Color Editor window (see illustration, below), highly specific colors can be
pinpointed and selected directly from the image in the image window. The Smoothness slider makes
color adjustments smoother, that is, by enhancing the smoothness a red color correction will slightly affect
neighboring colors like magenta and yellow as well.The dot controls in the color wheel are used to adjust
precisely what colors are affected by the corrections made. Moving the black dot in the center will move
the selected area. Moving the white dots in the outer boundary of the area will increase or decrease the
color coverage of the selection.

Hue rotation, Saturation and Lightness adjustments can be verified immediately on the screen. The
color wheel is a graphic illustration of the colors that are affected by the adjustments you are about to
make. By pulling the handles of the color wheel or the smoothness slider the area of affected color is
expanded or minimized.

2.2. Global Color Adjustments

If you prefer to adjust all colors simultaneously you can do so by adding a global color adjustment to the
list.

2.3. Color Editor Inspector

Profile adjustments should be carried out with care as there is always a risk of creating a profile that will
do more harm than good. In order to avoid this occurring, the Color Editor includes an inspection tool
that can help you verify the characteristics of the profile before you save it and begin to use it. Click the

 icon to open a Color Edit Inspector window with an image where the colors affected by the adjustments
are displayed.
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The Subject changes tab (see illustration, below ) is where the colors affected by the adjustments are
displayed. Colorized difference shows a monochrome image that displays color corrected areas with
colored highlights. Absolute difference shows a completely black image where only the color corrected
areas are visible.

The 3D Color Space (see illustration, below) provides a graphic illustration of the profile's color space.
The color space illustration gives a clear indication of whether or not the profile is suitable for use in a
professional color management workflow. A smooth and even color space indicates that the profile is
acceptable and vice versa.
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Chapter 12. Supported Meta Data and
IPTC Fields
The charts in the following sections list Capture One's support for meta data based on camera model.
An "X" means that the meta data field is supported, while "--" means that the field is not supported for
the model in question.

1. Phase One

MetaData

P 20 Hass V
tethered

P 25 Hass
V tethered

P 20 Un-
tethered

P 25
tethered
H101

P 20
Tethered
M645, C645

P 25 Un-
tethered
M645,

P 25
Tethered
M645,
C645, H645

Phase One
cameras:

and un-
tethered

and un-
tethered

M645,
C645, H645C645,

H645

Camera:

XXXXXXXCamera
Model

XXXXXXXCamera
Serial Num-
ber

XXXXXXXCamera
Firmware
Version

--------------Camera
Owner

--------------Lens

Exposure:

----XXXXXShutter
Speed

----XXXXXAperture

--------------Max Aper-
ture

--------------Exposure
Program

--------------Exposure
Mode

--------------Flash Mode

--------------Metering
Mode

--------------Drive
Mode/ Self
Timer

--------------Exposure
Compensa-
tion
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----Flash Com-
pensation

XXXXXXXISO Speed
Rating

----XXXXXFocal
Length

XXXXXXXAuto Focus
Mode

--------------White Bal-
ance Set-
ting

--------------Subject
Distance
Range

--------------Subject
Distance

File:

XXXXXXXFile Size

XXxxxXXImage Seri-
al Number

XXXXXXXCreation
Date

XXXXXXXImage Di-
mension

XXXXXXXimage
Quality

--------------Copyright

2. Canon

MetaData

G2G3G5Pro 130D60D300D10D20D1D
MKII

1Ds
MKII

1Ds1DCan-
on
cam-
eras:

Cam-
era:

XXXXXXXXXXXXXCam-
era
Model

X------XXXXXXXXXCam-
era
Serial
Num-
ber

XXXXXXXXXXXXXCam-
era
Firm-
ware
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Ver-
sion

XXXXXXXXXXXXXCam-
era
Own-
er

XXXXXXXXXXXXXLens

Ex-
pos-
ure:

XXXXXXXXXXXXXShut-
ter
Speed

XXXXXXXXXXXXXAper-
ture

XXXXXXXXXXXXXMax
Aper-
ture

XXXXXXXXXXXXXExpos-
ure
Pro-
gram

XXXXXXXXXXXXXExpos-
ure
Mode

XXXXXXXXXXXXXFlash
Mode

XXXXXXXXXXXXXMeter-
ing
Mode

XXXXXXXXXXXXXDrive
Mode/
Self
Timer

XXXXXXXXXXXXXExpos-
ure
Com-
pensa-
tion

XXXXXXXXXXXXXFlash
Com-
pensa-
tion

XXXXXXXXXXXXXISO
Speed
Rat-
ing

XXXXXXXXXXXXXFocal
Length
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XXXXXXXXXXXXXAuto
Focus
Mode

XXXXXXXXXXXXXWhite
Bal-
ance
Set-
ting

XXXXXXXXXXXXXColor
Space

--------------------------Sub-
ject
Dis-
tance
Range

--------------------------Sub-
ject
Dis-
tance

File:

XXXXXXXXXXXXXFile
Size

XXXXXXXXXXXXXImage
Serial
Num-
ber

XXXXXXXXXXXXXCre-
ation
Date

XXXXXXXXXXXXXImage
Di-
men-
sion

XXXXXXXXXXXXXimage
Qual-
ity

XXXXXXXXXXXXXCopy-
right

3. Nikon

MetaData

D70D100D2HD1HD1XNikon camer-
as:

Camera:

XXXXXCamera Model

----------Camera Serial
Number
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XXXXXCamera Firm-
ware Version

XXXXXCamera Owner

XXXXXLens

Exposure:

XXXXXShutter Speed

XXXXXAperture

XXXXXMax Aperture

XXXXXExposure Pro-
gram

XXXXXExposure Mode

XXXXXFlash Mode

XXXXXMetering Mode

----------Drive Mode/
Self Timer

XXXXXExposure Com-
pensation

----------Flash Compens-
ation

XXXXXISO Speed Rat-
ing

XXXXXFocal Length

XXXXXAuto Focus
Mode

XXXXXColor Space

XXXXXWhite Balance
Setting

XXXXXSubject Dis-
tance Range

----------Subject Dis-
tance

File:

XXXXXFile Size

----------Image Serial
Number

XXXXXCreation Date

XXXXXImage Dimen-
sion

XXXXXimage Quality

----XXXCopyright

4. Olympus

MetaData
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C 8080E-20E-10E-1Olympus cam-
eras:

Camera:

XXXXCamera Model

--XX--Camera Serial
Number

XXXXCamera Firm-
ware Version

XXXXCamera Owner

XXXXLens

Exposure:

XXXXShutter Speed

XXXXAperture

XXXXMax Aperture

XXXXExposure Pro-
gram

XXXXExposure Mode

XXXXFlash Mode

XXXXMetering Mode

--------Drive Mode/
Self Timer

XXXXExposure Com-
pensation

--------Flash Compens-
ation

XXXXISO Speed Rat-
ing

XXXXFocal Length

--------Auto Focus
Mode

XXXXColor Space

XXXXWhite Balance
Setting

--------Subject Dis-
tance Range

--------Subject Dis-
tance

File:

XXXXFile Size

--------Image Serial
Number

XXXXCreation Date

XXXXImage Dimen-
sion

XXXXimage Quality
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--------Copyright

5. Pentax

MetaData

*istDPentax camera:

Camera:

XCamera Model

--Camera Serial Number

XCamera Firmware Version

XCamera Owner

XLens

Exposure:

XShutter Speed

XAperture

XMax Aperture

XExposure Program

XExposure Mode

XFlash Mode

XMetering Mode

--Drive Mode/ Self Timer

XExposure Compensation

--Flash Compensation

XISO Speed Rating

XFocal Length

--Auto Focus Mode

XWhite Balance Setting

XSubject Distance Range

--Subject Distance

File:

XFile Size

--Image Serial Number

XCreation Date

XImage Dimension

Ximage Quality

XCopyright

6. Fuji

MetaData

S2S3Fuji cameras:
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Camera:

XXCamera Model

X--Camera Serial Number

XXCamera Firmware Ver-
sion

XXCamera Owner

XXLens

Exposure:

XX

XXShutter Speed

XXAperture

XXMax Aperture

XXExposure Program

XXExposure Mode

XXFlash Mode

XXMetering Mode

----Drive Mode/ Self Timer

XXExposure Compensation

----Flash Compensation

XXISO Speed Rating

XXFocal Length

----Auto Focus Mode

XXWhite Balance Setting

XXSubject Distance Range

----Subject Distance

File:

XXFile Size

----Image Serial Number

XXCreation Date

XXImage Dimension

XXimage Quality

XXCopyright

7. Konica Minolta

MetaData

A1A2Maxxum 7D, Dyn-
ax 7D, Alfa 7

Konica Minolta
cameras:

Camera:

XXXCamera Model

------Camera Serial
Number
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XXXCamera Firmware
Version

------Camera Owner

XXXLens

Exposure:

XXXShutter Speed

XXXAperture

XXXMax Aperture

XXXExposure Program

XXXExposure Mode

XXXFlash Mode

XXXMetering Mode

XXXDrive Mode/ Self
Timer

XXXExposure Compens-
ation

XXXFlash Compensa-
tion

XXXISO Speed Rating

XXXFocal Length

XXXAuto Focus Mode

XXXWhite Balance Set-
ting

XXXSubject Distance
Range

------Subject Distance

File:

XXXFile Size

------Image Serial Num-
ber

XXXCreation Date

XXXImage Dimension

XXXimage Quality

------Copyright

8. IPTC Information Editor
The IPTC Editor is accessed from the Collection menu. IPTC information is a kind of meta data that can
be added to hidden fields in your files.

The fields are available both in capture files and in processed files, where it is transferred to when the
image is processed.

Use the  button if you wish to merge in an existing set of IPTC information

clears all values.
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saves the template.

 undoes changes made.

 applies the settings to all selected captures.
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Chapter 13. Special Features
This section describes the special utility functions that the Capture One application provides.

1. Demoirize Plug-in
The Phase One Demoirize plug-in for Adobe Photoshop allows the removal of moiré patterns from images
by means of three different filtering modes: Advanced, Unicolor Textiles and Skin and Hair. The plug-in
is enclosed on the CD-ROM and will be placed in Adobe Photoshop's plug-ins folder when installing
Capture One the application.

The Demoirize plug-in window is divided into two separate previews: Original Image, which displays the
image before correction and Corrected Image, which displays the image after correction:

Using Advanced Mode on Skin and Hair: for skin and hair surfaces the optimal settings for the advanced
filter would be to position the Quality/Speed slider at Speed and the Pattern Size slider lose to Small.

Note

Large color moiré areas in hair may require a larger pattern size setting.

Using Advanced Mode on Textiles: on textile the optimal settings for the advanced filter would be to
position the Quality/Speed slider towards Speed, or in an intermediate position. Then move the Pattern
Size slider to the smallest possible setting. In many cases the masking of unicolored, or nearly unicolored
areas, may be carried out less accurately with the advanced filter compared to the Unicolor textiles filter.
Since masking depends very much on the type of image, it is recommended that you test different
masking and filter settings.

Advanced Mode: is a new filter tool. It is also the default mode of the Demoirize plug-in. In advanced
mode the filter estimates colors by means of the Quality/Speed slider and the Pattern Size slider. Often
the color moiré is visible by multiple red/green or blue/yellow areas of discoloration. These areas of
discoloration are seen as bands or stripes. The larger the band or stripe, the larger the pattern size
setting should be.
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Pattern Size: the best way of finding the optimal pattern size is by setting the Quality/Speed slider to
Speed while moving the Pattern Size slider towards Large. While moving the slider the effects of correc-
tions are seen on the screen. Selecting a larger than necessary pattern size will not generally enhance
the result. A circular arrow icon, that turns, indicates that the Demoirize filter is currently calculating image
data.

Quality/Speed: when large areas of moiré stripes and bands are present the Quality/Speed slider should
be set towards Quality, at the cost of Speed. Use the Quality setting when details smaller that the selected
pattern size should be less affected by the filtering.

2. Stitching Images
Capture One has the ability to stitch two or three images together to assemble one big TIFF or JPEG
file. (You must use Phase One cameras backs files inorder to do this). Using the Phase One FlexAdaptor
on a large format camera, it is possible to precisely take two or three images (depending on the camera
back) and stitch them together with the FlexAdaptor Stitch Processing function found in the Workflow
menu.

2.1. How to Stitch Images Together

To stitch images together, follow the procedure below:

1. Select the images that you want to stitch together in the thumbnail window.

2. Select Workflow>FlexAdaptor Stitch Processing.

3. The FlexAdaptor Stitch Developer window will be displayed. See illustration, below:

4.
If the images are not correctly positioned (from left to right) use the switch position button  to
swap them around.
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5. If the overlap is not correct, select a more appropriate type from the Overlap selection field.

6. Fill out the Image title field

7.
When you are satisfied with the settings that you have applied, click the Process button .

8. The images will be processed and a larger, single "stitched" image will be produced.

3. Lens Cast Calibration
To learn how Capture One can help you calibrate fixed lenses, please read Section 1.5, “Calibrating
fixed lenses”.
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Chapter 14. Preferences
The application preferences for Capture One PRO are accessed from the File > Preferences menu or
by holding down ALT+P.

1. Process Settings
Field description for the Process settings tab (see illustration below):

Naming This is where the way the file is processed from Capture One is set up.

When processing, the default naming can be set to a certain name and the
files will use that name when they are processed.

The TIFF and JPEG file extension can be changed if needed. We recom-
mend that they stay at .tif and .jpeg

If you place something in the name delimiter box it will appear after the de-
fault name.

Once you have set the name in the default name box you must check the
box use capture name as default name.

If you want the file to include the last 5 digits of the capture number check
the box.You can also choose include 3 digits for duplicated file names by
checking that box off.

By checking off the include capture information in TIFF caption, and include
Meta data information the information will appear in the processed file. The
thumbnails can be embed in the processed TIFF by checking off the box.

Processing Settings Checking Do NOT rotate the image will keep the image from rotating when
the file is processed. Disable Sharpening will not allow any sharpening to
be added to the processed file.

Using the banding suppression slider allows adjustment to the banding
which is the lack of shades of lightness in the file.

Noise suppression allows the noise level in the images to be adjusted.
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2. Capture Options
Field description for the Capture Options tab (see illustration below):

Naming Convention Naming convention delimiter allows a – to be added after the name and before
the digits.

The up and down arrow keys allows the amount of digits to be added to the
file name.

Suffix allows a suffix to be added to the name.

Check the allows include number box if a number should appear with the file
name.

Check use the cameras capture counter if you would like to use that instead
of the local counter.
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Batch Rename Check the offset value for batch rename if you want the files to be off set by a
certain amount.

Check the offset value for batch rename if you want the files to be off set by a
certain amount.

The check box process immediately will process the file as soon as the file is
taken.

Recognition If DB capture file have been saved with extensions other than .cap, ,capture,
.tif, .tiff one of the options must be selected without file extension or with incor-
rect file extensions.

Note

If these options are enabled capture file handling may slow down.
This only effects Phase One camera backs.
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3. 1394 and camera settings
Field description for the 1394 and Camera settings tab (see illustration below):

You can choose from the following:

• Automatic – Capture one will read the correct orientation from the camera and rotate the file in the
correct way.

• Force to landscape will make all images rotate to landscape.

• Force to portrait + 90 degrees will make all images rotate to portrait clock wise.

• Force to portrait - 90 degrees will make all images rotate to portrait counter clock wise.

Note

Selecting the capture orientation manually is only recommended on camera systems where
the orientation can not be determined automatically by the camera.

67

Preferences



4. Power and Portability
Field description for the Power and Portability tab (see illustration below):

When Camera battery indicator is checked the battery type can be choose. The options are 12V lead
acid or 2x 7.2V lithium- ion power module. Battery type

NOTE: When the camera is powered from other sources than Phase One Portable kit the battery indic-
ator is only updated after each capture has been completed.

Check use F11 for ISO change instead of host capture. This allows the hot key of F11 to be used for
ISO change.

5. Miscellaneous Settings
Field description for the Miscellaneous Settings tab (see illustration below):

Default Sharpening Soft or standard method of sharpening can be selected. Soft look
will soften the sharpening of the image and standard will not.
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• Amount: allows the amount of sharpening that needs to be applied
to the images to be adjusted by using the slider.

• Theshold: allows the amount of theshold that needs to be applied
with the amount of sharpening to the images.

Default Color Saturation The default color saturation can be modified by using the slider to
add or subtract the default saturation of an image.

Automatically open processed
images

To automatically open processed images check the box. Then you
have the choose of opening with the .TIF associated application
which will open the file with what software that is on the computer
that will open a .TIF file. The second option is to open the image to
a selected application which can be browsed to by clicking on the
choose button. The path of the application will be displayed below
the choose button.

Sound Settings Allows a sound to be set for camera is ready, capture is received
and camera or host reaches low power. By clicking the browse button
you can select the sound option of choose.

• If there is a need to scroll through numerous images and keep
the same focus point while scrolling the remember the setting for
automatic focus update should be set.

• Hide focus orientation frame automatically will make the square
showing were the focus point was selected not show up.

• Render background in solid gray allows the background skin of
the software shade of gray to be changed.

• Enable Jpeg browsing allows Jpegs to show up in the software.
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6. Save Options
Field description for the Save Options tab (see illustration below):

• Save on exit allows will save everything when the application is shut down.

• Save when changing collection save everything when there is a change from on collection to another
collection.

• Save when changing images save everything when there is a change from on image to another image.

• Save every X amount of images will save changes made during that duration of time.

Note

Excessive saving can degrade performance of other operations.
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7. Exposure Evaluation
This is where you provide the settings for over and under exposure warnings.
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8. Preview Cache
Field description for the Preview Cache tab (see illustration below):

Get info button shows the information of the preview cache like how much space it is using and the as-
sociated amount of RAW files.

Choosing a folder for previews to be stored in allows the folder to be changed in case the previews need
to be shared.

Automatically cleaning up the preview cache is recommend to have set at when a preview has not been
accessed for the specified number of day to be 5 to 10 days. This will help the performance of the
computer.

Clean up the preview cache now allow the Previews to be cleaned up through the button instead of
finding the folder and emptying it.
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Chapter 15. Keyboard Shortcuts
The following table describes the interfaces' keyboard shortcuts:

ShortcutDescription

F1Capture One Help (This user guide)

Alt - CCapture Tab

Ctrl - EExposure Tab

Alt - FFocus Tab

Ctrl - DDevelop Tab

F2Shift focus to the collection part of the window

F3Tab to the previous function tab

F5Exposure warning tool (toggle on and off)

F9Maximize preview window

F7Full screen mode

F8Toggle Landscape - Portrait view

BackspaceMove Highlighted Images (captures) to Move To
Folder.

DeletedMove Highlighted Images (captures) to Trash Col-
lection.

Ctrl + DeleteDelete highlighted images

InsertAdd selected image(s) to batch

Ctrl + ASelect ALL ( Capture Collection) or in (Batch queue)
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Chapter 16.Tips and Tricks
1.Tips on Daily Usage of Capture One

1.1. Optimizing white balance

Tip

If your image does not contain a satisfactory gray area, you should shoot the image again
and include a QP or MacBeth card in the scene.

Alternatively, use the If selected display on the white balance tab. While moving the eye
dropper around the image, the left window will indicate whether the area is suitable for white
balancing, by saying If selected (Good) or not suited, by saying If selected (poor).The window
on the right will show what the area will look like if the current position is used for white
balancing the image:

Not Suitable for White BalancingSuitable for White Balancing

1.2. Saving disk space by deleting previews

Tip

You can save a lot of disk space by periodically deleting unused items from the Previews
folder in C:\Program Files\Phase One\Capture One PRO.

You can read more about the different folders installed by Capture One in Section 2, “Standard Folders
Created During Installation”.

1.3. .work file naming convention

Tip

The .work files are named according to the following scheme: UID_[M]_[S]_[C]_[T]

An example could be:UID_Canon EOS-1D_00003E74_002000_20020805174645.work,
broken down like this:

ExampleDescription

Canon EOS-1DCamera model[M]

00003E74Serial number of the sensor[S]

002000Capture number assigned by
camera

[C]

20020805174645 (Which
would mean that the image

Timestamp in the format
yyyymmddhhmmss

[T]
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ExampleDescription

was captured at August 5th
2002 at 5:46:45 PM)

1.4. Reusing your white balance settings

Tip

To avoid re-doing the same white balance settings for every new image, Capture One allows
you to store your own white balance settings and reuse them on other images. Here's how
you do it:

1. Adjust the white balance settings to your liking.

2.
Click the Save White Balance button . This will bring up the Save As dialog:

3. Enter the name for your settings and click the Add button.

4. Now you can reuse your white balance settings by selecting them from the drop down
menu in the white balance tool:

For more details about white balancing, check out Chapter 7, White Balancing Images.

1.5. Calibrating fixed lenses

Tip

Lens cast is a result of the CCD being exposed to light from a very sharp angle and will
typically occur as a green cast in or corner of the image, stretching into a magenta cast in
the opposite corner.

Lens cast may occur when using Phase One H 25 with wide angle lenses like Horseman
Digiflex II, Hasselblad Flexbody or Hasselblad 905SWC or on other large format cameras
with different tilt or swing settings. On a medium format camera lens cast is very rare if using
fixed lenses from 60 mm to 120 mm.

To avoid lens cast, follow this procedure:
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1. Put a calibration plate in front of the lens - as close as possible - and capture.

To ensure correct exposure you might have to open a few f-stops in very light conditions
or put more light directly on the plate in dark setups.

2. Select the thumbnail of the captured image in Capture One and click on the White
Balance tab. in the tool. Now you'll see a section called Lens Cast Correction:

3. Click the Generate... button to save the calibration file - this calls up the Save As...
dialog:
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4. Now you can select the saved calibration file by browsing for it:

5. Check the Apply LCC for next Captures checkbox to apply the selected calibration for
the next series you shoot:

6. After saving your calibration file, you can delete the image used to create the LCC file.

Note

If you tilt the camera, zoom or in any other way change the way the light will
enter the lens, you need to create a new calibration file. If you're working with
large format or stitched images, you should check out Section 1.6, “Lens cast
calibration with image stitching”.
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1.6. Lens cast calibration with image stitching

Tip

When working with large format and stitched images, you must use a different lens cast
calibration file for each image in the aggregated image:

1. Create a calibration file along with each image you shoot and apply the calibration files
to the images. (See Section 1.5, “Calibrating fixed lenses” for details on how to create
calibration files and apply them to images).

2. To ease the white balancing you can apply the same settings to all images by selecting

them all and clicking the Apply to Selected Captures button: .

This brings up the following dialog:

3. Check the RGB, Sat/Hue and Kelvin/tone checkbox and click Apply.

1.7. Good sharpening

When working with the Focus Tool you need to adjust the Amount and Threshold sliders. Here are a
couple of hints to good practice:

Tip

The Amount is typically set around 100 for ink jet, 150 -250 for offset printing. Threshold is
used to define how many of the surrounding pixels are affected. Typically a noisy image will
have a higher threshold set, perhaps 12 -20. A clean image will need a very low threshold
of 2-4.

Keep checking the image in the focus window. For a web image, the image should look
correct on screen. For an image to be printed in a magazine or book, the preview should
ideally look slightly over-sharp on screen.
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Read more about focus and sharpening in Chapter 9, Focus and Sharpness.

1.8. Creating your own cropping dimensions

Tip

Capture One lets you create your own custom cropping dimensions that you can reuse in
the future. Here's how you create a new cropping menu item with your own dimensions:

1. Right click the crop icon and the following menu pops up:

2. Fill in the constraints for your crop, enter a name for it and click the Save button:

3. Now you'll see your new cropping in the selection list of available crops:
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1.9. Opening images into another application

When processing images you can enable Capture One to open the processed images immediately in
your preferred application, other than Capture One.

Tip

By ticking the Automatically open processed images checkbox, the image(s) will be opened
in the application you have associated with the file type you are producing, once the pro-
cessing is done:

Most likely the associated application is Adobe Photoshop.

Warning

Do not enable this feature if you're processing a large amount of images, as
your computer might freeze up.

You can read more about processing your images in Chapter 10, Processing Images.

1.10. Undoing rotations

Tip

If you are unhappy with the rotations you have performed on an image, Inserting a value of
0 in the Rotation Tool's free text area returns the image to its original rotation.

Read all about cropping and rotating in Section 3, “Cropping and Rotation”.

1.11. Activating Capture One software

Tip

To activate a license for your copy of Capture One, follow the instructions on how to activate
a license.
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1.12. Creating a contact sheet

Tip

Capture One lets you quickly create a contact sheet for clients to preview:

1. From the capture collection, select one of the images you wish to add to the contact
sheet.

2. Apply any adjustments to the image - little is usually needed for a preview version, like
auto adjusting the image in the exposure tool.

3. Now select the rest of the images for the contact sheet by holding down the Ctrl button
as you click once on each image you wish to select.

4. From the Collection menu, select QuickProof....

This will bring up the following dialog:

5. If you have applied cropping to the first image you selected, you should check the Use
image crop checkbox.

If you want the previews to be aggregated in an HTML page ready for publishing on
the Web, check the Create HTML index checkbox.

The rest of the options are pretty self-explanatory.
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6. Click the Process button and your contacts will now be created in the Destination folder.

1.13. Dynamic range from RAW

Tip

One of the major limitations of most DSLR cameras is the blowing out of highlight details
in high contrast situations. The solution to the problem in a film workflow was to shoot two
frames, one exposed for highlights and one for shadows. By combining them after scanning,
the best possible result could be achieved although with the associated risks of image mis-
registration.

RAW offers the ability to achieve the same result by simply outputting two versions of the
same file with exposure compensation or curves applied to the second output to give a
darker image.

Achieving this effective increase in dynamic range is very straightforward:

1. Capture the image, taking care to expose for the highlights and ensure that they are
not overexposed. On output, create two files, one with normal exposure and named
with the suffix top and the second, where the exposure compensation control and
contrast slider have been used to enhance the shadow detail with the original file name.

2. After processing as TIFF files, open both in Adobe Photoshop®. Select the Move Tool.
Drag the top file onto the other image while holding down the SHIFT key. The images
should be perfectly aligned.

3. Go to Layer > Add Layer Mask > Reveal all. Reset default colors to black and white
and then click on the rectangular Mask icon on the top layer in the layers palette. Use
a paintbrush set on 10% opacity to paint away the shadows on the top layer to reveal
more detail from the lower layer. Black paints away the top layer, white paints it back
in.

4. Once satisfied with the result, right click on the layer mask and select Apply Layer Mask.
Flatten the image and you are done.

2.Troubleshooting

2.1. I want to completely delete Capture One and all drivers from
my machine

Tip

If you want to remove everything installed by Capture One, follow this procedure:

Warning

Make sure you have backed up all images you wish to keep, as this procedure
whipes out everything, including images.

1. Remove Capture One with the Add/Remove Programs control panel (In Windows XP
you call up a list of control panels from the start menu).

2. Manually delete the folder C:\Program Files\Phase One (assuming you have installed
Capture One in the standard location).
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3. Hold down the Windows key and push "r" on the keyboard.

4. In the window that pop up, type in "cmd" and click OK:

5. Now a black window pops up and you have to enter a few commands directly in this
window. Enter the following commands and end each one with hitting enter/return on
the keyboard:

• del %windir%\system32\drivers\p1c1394.sys

• del %Windir%\INF\p1c1394.inf

6. Close the black window.

7. Open the Run window again by bolding down the Windows key and pushing "r". This
time you type in "regedit" (without the quotes). This brings up the "Registry Editor":

8. Delete the following two folders by right clicking them and selecting "Delete":

• Hkey_current_ user\Software\Phase One

• Heky_local_machine\System\CurrentControlSet\Services\P1C1394
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9. Restart your computer and all traces of Capture One should be gone.

2.2. How do I recover items from the trash?

Tip

If you've moved an image to the trash but want to bring it back into play, simply go to the
Trash pane of the collection window and drag the image from there to the collection tab you
wish to place it in.
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Chapter 17.Troubleshooting and
Feedback
Phase One Support: if you experience technical problems while working with the Phase One Capture
One application, try visiting our Phase One Support area on our corporate web at: http://sup-
port.phaseone.com. Here you will find links to our official support forum and the Phase One Knowledge
Base with searchable articles on troubleshooting and known issues.

Providing Feedback: Phase One values your feedback on our software. The easiest way for you to send
us your thoughts is by selecting the Capture One > Provide feedback... menu item from the Capture
One menu.You can also manually send an email to: <cowin-feedback@phaseone.com> We read
all feedback carefully, but please note that we cannot respond to the comments you send to this account.
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